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Installing Diamond Edition Software
Download the installation files.

Unzip the files at the computer on which you wish to install.

Run startup.exe – you can accept all the defaults (if you change the default destination folder, take 
note of it).

Once the installation is complete, you will need to run the Database Administrator tool to connect to 
an existing database or create your initial database.  While a shortcut will be available on the desktop, 
you will access the DBAdmin tool via the: 
Start Menu | All Programs | Diamond Edition | Tools | Database Administrator.

At the login window, click on the Configure button. If your company already has a database, you will 
point the program to that location (for instance N:\Data where “N” is a mapped network drive, and 
Data is a shared folder on the network). You will point to the folder just above the ODBC folder as the 
Common Directory. [You may need to consult with your company IT Dept for the Common Directory 
path, or you may be able to obtain it from the login screen of a computer already successfully running 
Diamond Edition Software.]

If you are running this program for the first time in your company, you can point to the location of your 
choosing for the Common Directory (on the network if you plan to share the database within your 
company, or locally on the computer’s hard drive if this is to be a stand-alone program & database).  
If this is the case, you will select next until you reach a list of missing tables at which point you will 
click on the checkbox next to “Fix All” (you will do this at two points during the DBAdmin process).  
When you click finish, you will have an empty database into which you can begin entering company 
and employee information.  You may need to enter an Activation Code to confirm your license.

If you have pointed DBAdmin to an existing database, you will select Next throughout the balance of 
the DBAdmin process.  If you receive any errors or are warned of database incompatibility, then you 
may not be pointing to the proper Common Directory location, or your database is of a different vesion 
than the program you have installed.  You will need to call us for further instructions if that occurs.

Upon completion of DBAdmin, you will be returned to the login screen.  You may hit Cancel to close 
this login window since you will still be in DBAdmin mode and will not need to launch that now that 
you have configured the program.

Launch the program from the shortcut on the desktop.  Log in with the User Name and Password 
provided to you by whomever administers the program for your company.  (New/blank database 
users can log in with Admin and no password to begin setting up the system.) 
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Continued on Next Page
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If you encounter an error trying to run the program (such as “Invalid Resource File” or “Cannot Update 
Cursor”), the following adjustments to User Access Control and/or Folder Permissions will need to be 
made:     [Please note that a network administrator or other IT person may need to participate in order to 
allow these changes or to fine-tune them to comply with your company’s security guidelines.]

Diamond requires that User Access Control (UAC) in Windows be set to “Never Notify” – this is done via 
Control Panel | User Accounts | Change User Account Control Settings. Drag the slider all the way down to 
the bottom, select OK, and then reboot the computer.

All users of the Diamond program on any particular computer will need Full Control at the application 
directory which would be C:\Program Files (x86)\SoftwareTech unless you changed the destination folder 
during the installation.  To set permissions, right-click on the SoftwareTech folder, select Properties, click 
on the Security tab – All Users should be given Full Control.

If you encounter an error during login (such as Invalid ODBC Connection or Invalid Path), then you may 
not have sufficient Network Privileges to access the shared database, or you may not have the correct 
path to the Common Directory specified.  Your company’s Network or System Admin should be able to 
resolve this for you.

If you encounter an error referencing missing dll files, Resource File Version Mismatch or Visual FoxPro 
Support Library, then you likely need to download the following and unzip it into your local 
Windows\SysWOW64 directory and/or where your Diamond Edition Software exe file is located: 
http://www.stisupport.net/support/VFPDLL.zip

Solutions to Common Problems 
During Installation or Launch

Remote Support is Available
We provide remote support via GoToAssist which allows us to connect to a computer at your location 
using an Internet connection.  Remote support sessions can be scheduled by calling the office at 
(540) 721-1000.  The computer to which we will connect must not only have Internet access, but also 
access to any shared network resources required (i.e. when the Common Directory is stored on a 
network server) as well as rights to allow the running of remote connection software.  What follows are 
directions for initiating a Remote Support Session with us.

Continued on Next Page
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Remote Support Continued
Please click on the following link to log in for remote assistance:

http://www.gotoassist.com/ph/softwaretech

The page displayed will look like this and you will need to fill in all three text boxes or you will generate an 
error. Please be sure we can identify you and your company by the names you choose.

Your Name:

Your Company Name: 

question 



 

Table of Contents 
 

Chapter 1 - Introduction ............................................................................................................................. 7 
This Manual Covers .................................................................................................................................. 7 
Installation and Setup ............................................................................................................................... 7 
Background Information ............................................................................................................................ 7 
Basic Operation ......................................................................................................................................... 7 
Reports ...................................................................................................................................................... 7 
Utilities ....................................................................................................................................................... 7 
Trouble Shooting ....................................................................................................................................... 8 
A Windows Program ............................................................................................................................... 8 
Conventions Used in this Manual ............................................................................................................. 8 

Chapter 2 - Installation and Setup ............................................................................................................ 9 
System Requirements ............................................................................................................................... 9 
Installation Procedure ............................................................................................................................... 9 
Database Connection and Setup – SQL Version ................................................................................... 15 
Database Connection and Setup – Diamond Version ............................................................................ 20 

License Activation ............................................................................................................................... 26 
Chapter 3 - Getting Started ...................................................................................................................... 29 

System Roles .......................................................................................................................................... 29 
Employee ............................................................................................................................................. 29 
Administrator ....................................................................................................................................... 29 
Super Administrator ............................................................................................................................. 29 
Database Administrator ....................................................................................................................... 30 

Getting Around ........................................................................................................................................ 31 
Read Only Access and Record Locks ................................................................................................. 32 

Super Administrator Options ................................................................................................................... 33 
Carry Over Options ............................................................................................................................. 33 
Carry Over Effective Year ................................................................................................................... 33 
Carry Over Type .................................................................................................................................. 33 
Fiscal Date ........................................................................................................................................... 33 
Global Recording Mode Change ......................................................................................................... 34 
Leave Request Conflict Scope ............................................................................................................ 34 
TimeKron Options ............................................................................................................................... 34 
Company Info ...................................................................................................................................... 34 

Workstation Options ................................................................................................................................ 35 
Low Resolution Reports ...................................................................................................................... 35 
Case Sensitive Password .................................................................................................................... 35 
Tool Tips .............................................................................................................................................. 35 
Exit Warning ........................................................................................................................................ 36 
Deletion Warning ................................................................................................................................. 36 
Auto Note Deletion .............................................................................................................................. 36 
Auto Adjustment Deletion .................................................................................................................... 36 
Auto Point Deletion .............................................................................................................................. 36 
Segment Merge Warning .................................................................................................................... 36 
Show Scheduled Recorded Time ........................................................................................................ 36 
Start Screen ......................................................................................................................................... 36 

E-mail Configuration................................................................................................................................ 37 



SoftTIME User Manual 2 
 

Enable E-mail Notification Check Box ................................................................................................. 37 
Auto-detect Settings Button................................................................................................................. 37 
Outgoing Mail Server ........................................................................................................................... 38 
Administrator E-mail ............................................................................................................................ 38 
Administrator Name ............................................................................................................................. 38 
E-Mail Protocol .................................................................................................................................... 38 
My Server Requires Authentication ..................................................................................................... 38 
User Name .......................................................................................................................................... 39 
Password/Confirm ............................................................................................................................... 39 
Test E-mail .......................................................................................................................................... 39 
Default E-mail Subject ......................................................................................................................... 39 

Startup Settings....................................................................................................................................... 39 
Settings ................................................................................................................................................ 40 
Setting Name ....................................................................................................................................... 40 
Recording Mode .................................................................................................................................. 40 
Shift ..................................................................................................................................................... 40 
Absence Categories ............................................................................................................................ 40 
Allowance Table .................................................................................................................................. 41 
Monthly Special ................................................................................................................................... 41 
TimeKron Hours .................................................................................................................................. 42 
Add Row Button .................................................................................................................................. 42 
Apply Information to Employees ......................................................................................................... 42 

Holiday Editor .......................................................................................................................................... 43 
User Defined Icons ................................................................................................................................. 45 

Category Name ................................................................................................................................... 45 
Category Abbreviation ......................................................................................................................... 45 
Allowed Category ................................................................................................................................ 45 
Category Color .................................................................................................................................... 46 
Reset Color Files ................................................................................................................................. 46 
Picture Abbreviation ............................................................................................................................ 46 
Show name on icon ............................................................................................................................. 46 
Original Picture Path ........................................................................................................................... 46 
Reset Picture Files .............................................................................................................................. 46 

E-Mail Notification ................................................................................................................................... 47 
Department Roster .................................................................................................................................. 48 
Point Categories...................................................................................................................................... 49 

Chapter 4 - Employee Information .......................................................................................................... 51 
Select an Employee ................................................................................................................................ 52 
Add Employee ......................................................................................................................................... 53 
Remove Employee .................................................................................................................................. 53 
Employee Information ............................................................................................................................. 54 

Hire Date/Termination Date ................................................................................................................. 54 
E-mail .................................................................................................................................................. 54 
Department .......................................................................................................................................... 54 
Recording Mode .................................................................................................................................. 55 
Default Startup Setting ........................................................................................................................ 55 
Shift Information .................................................................................................................................. 55 
Photos ................................................................................................................................................. 56 
Security Profile .................................................................................................................................... 57 

FYI ........................................................................................................................................................... 58 



Table of Contents 3 
 

Recorded ............................................................................................................................................. 58 
Allowed ................................................................................................................................................ 58 
Remaining ........................................................................................................................................... 58 
Absence Categories ............................................................................................................................ 59 
Show Scheduled Recorded Time ........................................................................................................ 59 
Current Points...................................................................................................................................... 59 

Edit Categories ........................................................................................................................................ 59 
Category .............................................................................................................................................. 60 
Year Type ............................................................................................................................................ 60 
Recording Year.................................................................................................................................... 60 
Carry Over ........................................................................................................................................... 60 
Accruals ............................................................................................................................................... 60 
Yearly Allowance ................................................................................................................................. 60 

Chapter 5 - Monthly Calendar Screen..................................................................................................... 61 
Monthly Calendar .................................................................................................................................... 61 
Detail information .................................................................................................................................... 62 
TimeKron Type ........................................................................................................................................ 62 

Standard .............................................................................................................................................. 62 
Hours Worked...................................................................................................................................... 63 
Start Time ............................................................................................................................................ 63 

Note Tool ................................................................................................................................................. 63 
Eraser Tool .............................................................................................................................................. 64 
Adjustment Tool ...................................................................................................................................... 64 
Points Tool .............................................................................................................................................. 66 
Absence Tools ........................................................................................................................................ 67 
Half Day Tool .......................................................................................................................................... 68 

Chapter 6 - Year at a Glance Screen ....................................................................................................... 69 
Chapter 7 - Day Screen ............................................................................................................................ 71 

Selecting a Year, Month and Day ........................................................................................................... 72 
Daily Activity ............................................................................................................................................ 72 
TimeKron Hours ...................................................................................................................................... 74 
Adjustments ............................................................................................................................................ 74 
Points ...................................................................................................................................................... 75 

Chapter 8 - Leave Request System ......................................................................................................... 77 
Chapter 9 - Reports .................................................................................................................................. 85 

Common Report Features ...................................................................................................................... 85 
Report Title .......................................................................................................................................... 85 
Report Description ............................................................................................................................... 85 
Administrator Title Lock ....................................................................................................................... 85 
Low Resolution Printer ........................................................................................................................ 85 
Company Logo in Header ................................................................................................................... 85 
Company Name in Title ....................................................................................................................... 86 
Preview ................................................................................................................................................ 86 
E-mail .................................................................................................................................................. 86 
HTML ................................................................................................................................................... 87 

Employee Reports................................................................................................................................... 87 
Annual Summary Report ..................................................................................................................... 89 
Employee Details Report ..................................................................................................................... 90 



SoftTIME User Manual 4 
 

Employee Information Report.............................................................................................................. 91 
Employee Profile Report ..................................................................................................................... 92 
Month at a Glance Report ................................................................................................................... 94 
Year at a Glance Report ...................................................................................................................... 95 
Employee FYI ...................................................................................................................................... 96 

Department Reports ................................................................................................................................ 98 
Absence Report ................................................................................................................................... 99 
Absence Summary Report ................................................................................................................ 100 
Adjustment Report ............................................................................................................................. 101 
Allowance Projection Report ............................................................................................................. 102 
Annual Overview Report ................................................................................................................... 104 
Daily Report ....................................................................................................................................... 105 
Department Details Report ................................................................................................................ 106 
Department Reconciliation Report .................................................................................................... 107 
Lateness Details Report .................................................................................................................... 108 
Lateness Summary Report ................................................................................................................ 109 
Monthly Report .................................................................................................................................. 110 
Quick List Report ............................................................................................................................... 112 
Shift Analysis Report ......................................................................................................................... 117 

Miscellaneous Reports .......................................................................................................................... 118 
Anniversary List Report ..................................................................................................................... 119 
Birthday List Report ........................................................................................................................... 120 
Department List Report ..................................................................................................................... 121 
Holiday Details Report ....................................................................................................................... 122 
Holiday List Report ............................................................................................................................ 123 
Holiday Reconciliation Report ........................................................................................................... 124 
Startup Settings Report ..................................................................................................................... 125 

Points Reports....................................................................................................................................... 126 
Perfect Attendance ............................................................................................................................ 126 
Point Details ...................................................................................................................................... 127 
Point Infractions ................................................................................................................................. 128 
Point Ledger ...................................................................................................................................... 129 
Point Totals........................................................................................................................................ 130 
Excessive Points ............................................................................................................................... 130 

Chapter 10 - Utilities ............................................................................................................................... 133 
Importing Data....................................................................................................................................... 133 

Generic Data File .............................................................................................................................. 134 
Importing from SoftTIME ................................................................................................................... 137 

Exporting Data ...................................................................................................................................... 138 
Report Title ........................................................................................................................................ 138 
Columns 1-7 ...................................................................................................................................... 138 
Departments ...................................................................................................................................... 139 
Include Terminated Employees ......................................................................................................... 139 
Date Option ....................................................................................................................................... 139 
Low Resolution Printer ...................................................................................................................... 139 
Company Logo in Header ................................................................................................................. 139 
Company Name in Title ..................................................................................................................... 139 
New/Open/Save Buttons ................................................................................................................... 139 
Export Button ..................................................................................................................................... 140 
Print Button ........................................................................................................................................ 140 



Table of Contents 5 
 

Preview Button .................................................................................................................................. 140 
Printer Setup ......................................................................................................................................... 140 
Help Menu ............................................................................................................................................. 140 
License Agreement ............................................................................................................................... 141 
Upgrade License ................................................................................................................................... 141 
Web Update and Automatic Upgrades ................................................................................................. 141 
More Sources for Help .......................................................................................................................... 144 

Software Techniques on the WEB .................................................................................................... 144 
Technical Support Options ................................................................................................................ 144 
About SoftTIME ................................................................................................................................. 144 

DB Administration Mode ....................................................................................................................... 145 
Chapter 11 - Trouble Shooting .............................................................................................................. 147 

Technical Support ................................................................................................................................. 147 
Common Problems and Solutions ........................................................................................................ 148 

Index ........................................................................................................................................................ 151 



Chapter 1 - Introduction 7 
 

 

CCChhhaaapppttteeerrr   111   ---   IIInnntttrrroooddduuuccctttiiiooonnn   

This Manual Covers 
• Installing SoftTIME and importing information from other database programs 

• Setting and maintaining company absence policy 

• Maintaining individual and department records 

• Basic operation - recording absences and reasons 

• Producing reports 

• Utilities 

• Trouble shooting  

Installation and Setup 
For system requirements and installation instructions see Chapter 2 – Installation and Setup. 

Background Information 
To establish company-wide holiday policies and set up departments, see Chapter 3 – Getting Started.  To 
customize attendance information for each employee, taking into account such things as length of service 
and shift work, see Chapter 4 – Employee Information. 

Basic Operation 
To learn how to perform the most frequently used SoftTIME functions, Chapters 4-7 demonstrate how to 
keep routine attendance records for each employee. 

Reports 
To see samples of the reports SoftTIME can generate, see Chapter 8 – Reports. 

Utilities 
To review SoftTIME Utilities, see Chapter 9 - Utilities 
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Trouble Shooting 
For fast help with common problems, see Chapter 10 – Trouble Shooting. 

A Windows Program 
SoftTIME runs under the Microsoft Windows Operating System.  This manual assumes that you know how 
to perform routine mouse and keyboard operations in this environment. 

Conventions Used in this Manual 
In this manual, we put [square brackets] around keyboard keys you must press, such as function keys [F1], 
the [Tab] key, the [Enter] or [Return] keys.  Prompts (messages and labels SoftTIME displays on screen) are 
shown with this typeface.  Information you enter into data fields is shown with this typeface. 
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CCChhhaaapppttteeerrr   222   ---   IIInnnssstttaaallllllaaatttiiiooonnn   aaannnddd   SSSeeetttuuuppp   
 

This chapter familiarizes you with the minimum and recommended system requirements necessary to run 
SoftTIME. 

 

The Installation Procedure is covered in detail.  It leads you through the basic install steps and then follows 
with advanced setup procedures.  If you have questions concerning the installation or setup, do not hesitate 
to call Software Techniques’ Customer Support. 

System Requirements 
With your purchase of SoftTIME, your license defines a maximum number of employees.  Minimum system 
requirements are fine if you have 100 or fewer employees.  As the number of users grows, processing speed 
slows and you may wish to increase processor speed and/or memory size to recommended levels. 

 

Resource Minimum Recommended 

Hard Drive 

(local and network) 

500 Megabytes (MB) 2 Gigabytes (GB) 

RAM 1 GB 2 GB or Higher 

Operating System Windows XP Windows XP / 7 

Database Server 

(SQL version only) 

MS SQL Server 2005 MS SQL Server 2008 R2 

Installation Procedure 
1. Make sure that your system meets or exceeds the minimum SoftTIME System 

Requirements. 

2. Insert the SoftTIME CD into the CD-ROM drive. 

3. If your system has the Auto Run feature set on, skip to Step 6.  Otherwise, Click the 
Microsoft Windows  Icon. 
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4. Click Run and the following screen will appear. 

 

Run Startup  

5. In the Run dialog Command Line box, type d:\startup.exe and click OK.  If your CD-
ROM has a different letter than “d”, substitute that letter for “d”.  For example, 
e:\startup.exe.  The following screen will appear. 

 

Startup 

6. You may now install SoftTIME.  Click Install SoftTIME. 

At this point, the following screen will appear. 
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Install Shield - step 1 

7. Click Next to continue.  The following screen will appear. 

 

Install Shield - step 2 

8. Enter Customer Information and decide who is to use this software.  Click Next to continue 
and the following screen will appear. 
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Install Shield - step 3 

The above screen will allow you to change the destination folder.  The Destination 
Folder is the folder where the SoftTIME software will be installed.  Installing to the 
default folder is recommended. 

 

Note - The Destination Folder is where the software program is loaded.  This may be different 
than your Common Directory (discussed later in the Startup section of this chapter).  Also, the 
installation directory is not necessarily located on the same disk or computer where your Data is 
located.  The software works best when installed directly on the client, to take full advantage of 
the nature of C/S architecture. 

9. After selecting an installation directory, click Next to continue the installation.  The following 
screen will appear. 

 

Install Shield - step 4 

If you have made a mistake, you may go back and correct it at this time. 
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10. If you agree with the information stated, click Install to continue.  The following screen will 

appear. 

 

Install Shield - install in progress 

Install Shield will keep you abreast of its progress. 
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When the installation has been completed, the following screen will appear. 

 

Install Shield - install complete 

11. The installation is now complete.  Click Finish and you will be returned to the following 
screen. 

 

Startup 

12. You are now ready to run SoftTIME and setup your database connection. 

13. Click Close to continue. 
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Database Connection and Setup – SQL Version 
Only use this section if you are using the SoftTime SQL Server Edition.  If you are using SoftTime Diamond 
Edition, skip ahead to Database Connection and Setup – Diamond Version. 

1. Before you will be able to continue you will need to make sure that you work with your DBA to 
create an empty SQL database.  Make sure that the database is large enough to support all your 
data.  Also make sure your DBA has given you a SQL account with the necessary security to create 
all the tables that SoftTIME will create. 

Write down the SQL Server Name for reference _________________________________ 

Write down the SQL Database Name for reference _______________________________ 

Write down or memorize your SQL account User Name ___________________________ 

(Also memorize your SQL account password) 

2. Next, work with your DBA to make sure you have a SQL connection from your client workstation.  
The next few steps will help you help you complete the connection process.  However, you will not 
be successful unless you have the SQL client tools installed and you can connect to your SQL server 
via your network.  In other words, it will be probably be best if your DBA assists you in the next few 
steps. 

Most SQL environments will require the SQL DBA to perform some of the database installation steps. 

Use the Database Administrator Tool for SoftTIME SQL Server Edition to establish the SQL 
database connection and setup the database tables.  From the Windows start menu: 

 

 

Selecting DB Admin mode from the Windows Start Menu 
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3. After starting SoftTIME, you will be asked to review the license agreement. 

Be sure to read through the whole License Agreement: 

 

License Agreement 

 If you agree with the terms of the license agreement, click .  If you do not 

agree, click .  Click OK to continue. 

4. If you clicked I Accept after installing SoftTIME, the following login screen will appear. 

 

DB Administrator Login 

At this juncture you will be unable to login.  The first thing you will need to do is configure your 
Common Directory and setup your ODBC Connection.  To do this click on Configure.  If the button 
says "Change" instead of "Configure" then you are in the wrong place.  You need to be running 
the DB Admin Tool first before running the main application. 

5. The first thing you will need to do is establish a common directory.  Unlike other versions of 
SoftTIME, your data will be stored in a SQL database.  However, SoftTIME still needs a common 
area to store common files that can be accessed by all users.  It is usually best to store this on a 
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networked file server that is on the same network as your SQL database server. 
 

 

New Common Data 
 

Note to the Network Administrator - The common directory serves as a central gateway for the application.  It 
contains graphical images, user defined absence icons, encrypted email configuration files, and encrypted ODBC 
connection strings, and report templates as well as other common components shared by all users.  It is important 
for consistency that all users, who are accessing the same database, share the same Common Directory. 

 Select a common directory on a shared network drive or shared network resource, such as 
“T:\DSQL Data\Common”. 

6. The next step is to connect to the SQL Server and create an ODBC connection. 
 

 

Establish an ODBC Connection string 

 Enter the name of the SQL Server and the SQL Database that you recorded earlier.  Set the trusted 
connection checkbox setting based on the authentication method your SQL server database is using.  
If you are not using a trusted connection you will need to supply a SQL server account id and 
password.  If you are not sure contact your SQL DBA.  You can test your connection by clicking on 
Test Connection.  Once you have made a successful connection, click on Next. 

7. At this point you will have the option of checking for updates on the Web. 
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This step is not always necessary, but is probably a good idea.  In some instances where there has 
been a change to the database structure, you may have to check for and download an update.  If 
there are updates available, they will be downloaded to the common directory.  Each workstation will 
update itself from the common directory.  Click Next to move on to the next step. 

8. After connecting to the SQL Database, SoftTIME will automatically test the database for structural 
integrity.  If you have just installed the application, the database should be empty. 

 

 

Empty database structure 

 To create a new database or to repair an existing database with a broken database structure click on 
Fix All.  SoftTIME will automatically construct all the missing database components.  Once you have 
a working database structure, click on Next. 

9. The next step is to make sure that the data in the database is initialized for use.  At this juncture the 
data should be empty and will need to be created just like the database structure was created. 
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Empty data in database 

 SoftTIME can easily create an empty database for you.  However, if you already have a non-SQL 
version of SoftTIME you can do a Total Import.  This is the best way to import data.  It will preserve 
all of your settings without having to set everything up from the beginning. 

If you would rather start from scratch with a blank database you can click on Fix All. 
 

 

Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click on Finish and you 
can return to the Database Administrator Logon screen. 
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Return to Database Administrator Login 

 You can now click on Cancel to exit DB Administrator mode.  With everything completely setup you 
will now be able to access SoftTIME from the icon on your desktop or from the Windows Start menu. 

 

Database Connection and Setup – Diamond Version 
Only use this section if you are using the SoftTime Diamond Edition.  If you are using SoftTime SQL Server 
Edition, check out the previous section, Database Connection and Setup – SQL Version. 

1. The next few steps will help you help you complete the connection process. 

Use the Database Administrator Tool for SoftTime establish the database connection and setup 
the database tables.  From the Windows start menu, click Tools-Database-Administrator. 

 

 

Selecting DB Admin mode from the Windows Start Menu 
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2. After starting SoftTIME, you will be asked to review the license agreement. 

Be sure to read through the whole License Agreement: 

 

License Agreement 

 If you agree with the terms of the license agreement, click .  If you do not 

agree, click .  Click OK to continue. 

3. If you clicked I Accept after installing SoftTIME, the following login screen will appear. 

 

DB Administrator Login 

At this juncture you will be unable to login.  The first thing you will need to do is configure your 
Common Directory and setup your ODBC Connection.  To do this click on Configure.  If the button 
says "Change" instead of "Configure" then you are in the wrong place.  You need to be running 
the DB Admin Tool first before running the main application. 

4. The first thing you will need to do is establish a common directory.  SoftTIME needs a common 
area to store common files that can be accessed by all users.  It is usually best to store this on a 
networked file server that is on the same network as your database server. 
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New Common Data 
 

Note to the Network Administrator - The common directory serves as a central gateway for the application.  It 
contains graphical images, user defined absence icons, encrypted email configuration files, and encrypted ODBC 
connection strings, and report templates as well as other common components shared by all users.  It is important 
for consistency that all users, who are accessing the same database, share the same Common Directory. 

 Select a common directory on a shared network drive or shared network resource, such as 
“T:\DSQL Data\Common”. 

5. This step will show you where your database will be stored in relation to the common directory.  It 
also shows the type of database used.  Click Next to go to the next step. 

 

 

ODBC Connection 

6. At this point you will have the option of checking for updates on the Web. 
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This step is not always necessary, but is probably a good idea.  In some instances where there has 
been a change to the database structure, you may have to check for and download an update.  If 
there are updates available, they will be downloaded to the common directory.  Each workstation will 
update itself from the common directory.  Click Next to move on to the next step. 

7. After connecting to the database, SoftTIME will automatically test the database for structural integrity.  
If you have just installed the application, the database should be empty. 

 

 

Empty database structure 

 To create a new database or to repair an existing database with a broken database structure click on 
Fix All.  SoftTIME will automatically construct all the missing database components.  Once you have 
a working database structure, click on Next. 

8. The next step is to make sure that the data in the database is initialized for use.  At this juncture the 
data should be empty and will need to be created just like the database structure was created. 
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Empty data in database 

 SoftTIME can easily create an empty database for you.  However, if you already have a non-SQL 
version of SoftTIME you can do a Total Import.  This is the best way to import data.  It will preserve 
all of your settings without having to set everything up from the beginning. 

If you would rather start from scratch with a blank database you can click on Fix All. 
 

 

Database successfully created - DB Admin setup complete 

 Once the data is created the database administration setup is completed.  Click on Finish and you 
can return to the Database Administrator Logon screen. 



Chapter 2 - Installation 25 
 
 

 

Return to Database Administrator Login 

 You can now click on Cancel to exit DB Administrator mode.  With everything completely setup you 
will now be able to access SoftTIME from the icon on your desktop or from the Windows Start menu. 
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License Activation 
1. Now you should be ready to run SoftTIME for the first time. 
 

 

Desktop Icon 
 

 

First time application login 

 To enter SoftTIME for the first time, login in as Admin with no password.  Once you get in you can 
change your User Name and password.  If you did a Total Import you will be able to use the User 
Names and Passwords that were imported, instead. 

2. Now you should be ready to activate your license. 
 

 

Enter your activation code 

 Your CD and CD case should contain an Activation Code.  Simply enter the code and click on OK and 
you are ready to use SoftTIME.  Once activated, your database will be locked into a maximum 
number of employees.  If your company exceeds that number of employees you can contact your 
sales representative to get a license extension.  You will then receive a new activation code, which 
can be entered through the Upgrade License Utility. 
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3. If this is the first workstation you have installed SoftTIME, you may be required to initialize the 

graphical icons.  You can initialize them to include the name of absence category on the icon or 
you can just have pictures without names. 

 

 

Initialize Pictures 
 Congratulations!  You are now ready to begin using SoftTIME. 
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CCChhhaaapppttteeerrr   333   ---   GGGeeettttttiiinnnggg   SSStttaaarrrttteeeddd   
 

Now that you have installed SoftTIME, you will want to configure the software to your specifications.  There 
are 8 areas that you should configure to setup your environment: 

• Super Administrator Options 

• Workstation Options 

• E-mail Configuration 

• Startup Settings 

• Holiday Editor  

• User Defined Icons  

• E-mail Notification 

• Department Roster  

• Point Categories 
 

Visit these sections in order for best results. 

System Roles 
In order to better understand which users have access to which options in SoftTIME, it is helpful to cover the 
System Roles. 

Employee 
Employees have read-only access to their own information.  They can view their own calendars and reports.  
They cannot modify or create any category or time-related transactions.  Employees can also create leave 
requests and submit them to their supervisors. 

Administrator 
The Administrator role is allowed to view and modify time records for a certain subset of employees.  This 
can be for one or more departments.  The Super Administrator sets their privileges. 

The Administrator role does most of the data entry into the SoftTIME system.  They can access and modify all 
employees in their purview, but can not alter any global configuration settings.  

Super Administrator 
The Super Administrator has all privileges on the SoftTIME system.  They can do everything an Administrator 
can do as well as setting global configuration parameters and assigning Administrator roles and privileges.  
The Super Administrator can also give users Super Administrator options.  
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Super Administrators have access to all employees, all the time.  They also have access to all sections of the 
program.  Super Administrators can log in as regular administrators if they want.  If you log on as a Super 
Administrator, the database will be locked and you will be the only one allowed to use the database at that 
time. 

Database Administrator 
The Database Administrator is a special role that works outside of the SoftTIME application.  This person is 
responsible for making sure that your Database is functioning properly.  This includes creating the database, 
making sure the database server is operating smoothly, making sure the SoftTime database is secured and 
accessible by all those that need to access, and finally making sure it is backed up on a routine schedule. 

 

Feature (see menu) Employee Admin SA (shared) SA (users locked out) 

Export  X X X 

Import    X 

Startup Settings    X 

UDI    X 

Holiday    X 

Departments    X 

Point Categories    X 

Employee Leave X X X X 

Leave Approval  X X X 

SA Options    X 

Email Configuration   X X 

Upgrade License    X 

Web Update    X 

Email Notification  X X X 

Employee Reports X X X X 

All Other Reports  X X X 

Security feature grid (X = access allowed) 
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Getting Around  
SoftTIME is a standard Microsoft Windows application.  You should be familiar with concepts such as menus, 
clicking, double-clicking, drag & drop and therefore have no problem learning your way around. 

 

SoftTIME - Main Screen 

The default screen of SoftTIME shows a list of employees and a form with 4 tabs: Month, Year, Day, and 
Employee Information.  Each of these tabs has their own section later in the document.  There is also a 
Department drop-down list box so you can filter your list of employees by department. 

SoftTIME also depends on “menu navigation” to find some features.  Explore the menus.  Depending on your 
role in SoftTIME, you will have access to some of the features.  The others will be disabled. 

 

SoftTIME operates by interfacing with the Database.  This is handled internally by the application as it 
communicates with the database Server.  The database server can maintain several databases.  To make 
sure you are accessing the correct database you can always look at the application title bar.  It should include 
the name of the database in square brackets (e. g. [DiamondSQL_Data]).  If the correct database does not 
appear in the title bar, exit the application and contact your Database Administrator. 
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Read Only Access and Record Locks 
As you select an employee, SoftTIME will communicate with the database server to get the records for that 
employee.  The first user to access a set of records will place a lock on the records for that employee.  When 
the second user attempts to access the same records at the same time he will only be able to access the 
records in Read-only mode.  This will prevent two users from changing the records at the same time.  When 
a record is accessed in Read-only mode the screen title will display "[READ ONLY]" next to the employee 
name and the screen will be a darker shade of grey. 

 

Main Screen - Read Only mode 
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Super Administrator Options 
To enter this mode, click on Tools->Super Administrator Options.  This screen allows the Super 
Administrator to configure global settings that will apply across SoftTIME.  

 

Super Administrator Options 

Carry Over Options 
These options allow you to choose aspects of carry over policy for your company.  Note that carry over 
maximum amounts are stored locally for each employee and category.  These are covered in the Edit 
Categories section.  

Carry Over Effective Year 
This sets the first recording year you want to carry over to.  

Carry Over Type 
This allows you to specify whether to carry over only unused time or to keep track of time people took over 
their allotment.  

Fiscal Date 
This sets the beginning of your company’s fiscal year. 
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Global Recording Mode Change 
This option allows you to change the time increment between hours and days for all employees.  It will apply 
to all time measurements across SoftTIME. 

Leave Request Conflict Scope 
These options allow you to define the basic way that the Leave Request feature will operate.  When 
requesting and approving leave requests it is often helpful to determine if other employees are likely to be 
absent at the same time.  This could create a potential conflict.  SoftTime allows you to view the potential 
absence conflicts on the Conflict Display Screen.  Smaller business will probably want to check "All 
Departments" to determine their staffing level around the vacation season.  Larger businesses with several 
hundred employees will probably want to limit the conflict list to just those employees in the same 
department as the employee requesting leave. 

There are also two options that allow Department Level Administrators to serve as effective managers for 
authorizing leave requests and checking possible leave conflicts.  Some department level administrators only 
have Read Only access to employee absences.  However, if these department level administrators will be 
responsible for approving leave, they will need their security rights extended. 

TimeKron Options 
Currently these options do not apply.  However, once TimeKron becomes available, you will be able to use 
these options to integrate TimeKron time worked punch data with your SoftTime  data.  For more information 
on integrating TimeKron, punch clocks, and other biometric devices with SoftTIME, contact our sales 
department at (540)721-1000.  

Company Info 
This information allows you to customize reports and printouts with your company name and logo.  The 
name entered here will appear wherever a report or screen displays the company name. 

Pressing the Get Company Logo button will present you with a file picker dialog to choose an image file for 
your company logo.  Reports allow you to select a checkbox to display this logo on printouts. 
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Workstation Options  
To enter this mode, click on Tools->Workstation Options.  These options apply only for the specific 
workstation on which SoftTIME is running.  They govern certain settings that apply to the user’s session and 
display preferences. 

 

 

Workstation Options 

 

Low Resolution Reports 
This option allows you to specify that you have a lower resolution printer.  The report generator will forgo the 
fancier shading it uses when generating reports. 

Case Sensitive Password 
This applies to the passwords for THIS WORKSTATION ONLY.  If it is set then anyone logging into this 
machine will be required to enter a case sensitive password.  

Tool Tips 
Checking this box will present you with a tool tip on the cursor wherever one is available in SoftTIME.  This 
can be helpful when you are first learning the software and can be turned off after you are familiar with the 
program. 
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Exit Warning 
This option will alert you any time SoftTIME is closing to make sure you actually wish to end your session. 

Deletion Warning 
This option will confirm deletion any time you attempt to delete anything in SoftTIME.  

Auto Note Deletion 
When you delete values from an employee day, there may be notes attached to the day in addition to an 
assigned category.  If this option is set, the delete tool will automatically delete any notes associated with the 
day.  If it is not set, you will be prompted before the note is deleted. 

Auto Adjustment Deletion 
When you delete values from an employee day, there may be adjustments attached to the day in addition to 
an assigned category.  If this option is set, the delete tool will automatically delete any adjustments 
associated with the day.  If it is not set, you will be prompted before the adjustment is deleted. 

Auto Point Deletion 
When you delete values from an employee day, there may be points attached to the day in addition to an 
assigned category.  If this option is set, the delete tool will automatically delete any points associated with the 
day.  If it is not set, you will be prompted before the points are deleted. 

Segment Merge Warning 
Each category can be applied to all or part of a day.  Each block of time is referred to as a segment.  When 
segments overlap, SoftTIME overwrites the previous segment with the values of the new segment.  This is 
known as a Segment Merge.  If this option is checked, SoftTIME will warn you before the segments are 
merged. 

Show Scheduled Recorded Time 
By default, SoftTIME shows remaining time allotted an employee for each category (i.e. vacation, illness,…) 
as of today.  So if you have vacation scheduled in advance, it will not be deducted from your allotted 
remaining time for that category until the vacation occurs. 

If this option is checked, remaining time will include all scheduled time even if it has not already occurred.  
This can help in planning and viewing your remaining time. 

Start Screen 
This allows you to set your default screen when you enter SoftTIME.  You can pick from the 4 tabs on the 
main screen of the application. 
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E-mail Configuration 
To enter this mode, click on Tools->E-mail Configuration.  These settings are available to the Super 
Administrator ONLY.  They basically configure SoftTIME to generate email via your existing e-mail 
server. 

 

E-mail configuration 

Enable E-mail Notification Check Box 
This is the first step to setting up your e-mail configuration.  When this box is checked all of the other settings 
become enabled.  Without e-mail notification enabled, SoftTIME will not attempt to generate emails. 

Auto-detect Settings Button 
This handy button will go out onto the Super Administrator’s computer and detect the server and account 
that is set up in the default mail client.  It will present you with a confirmation dialog showing what it was 
able to detect. 
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Auto-detect Settings 

You can either accept the detected settings by pressing OK or ignore them by pressing Cancel. 

Outgoing Mail Server 
This is the SMTP server name that handles your outgoing mail.  It can be found in the configuration settings 
of your mail program.  It is usually in the form “mail.yourcompany.com” or “smtp.yourcompany.com”. 

Administrator E-mail 
This is the e-mail address SoftTIME will use to generate emails.  It must be a valid account on the specified 
mail server above.  This is also the account that will be notified if there is a problem sending e-mails. 

Administrator Name 
This is the name associated with the e-mail account above.  It will be filled in by the Auto-Detect or you can 
change it so the generated emails appear as if they come from a certain person in your organization. 

E-Mail Protocol 
Most SoftTIME users should be able to use their e-mail server with the default protocol.  This is an internal 
SoftTIME protocol known as "Protocol S".  In some rare instances, you may experience problems with your e-
mail server settings.  In these situations a certified Technical Support Engineer may suggest that you try 
using the alternate protocol "Protocol W". 

My Server Requires Authentication 
With security as a concern these days, most mail servers require authentication.  However, since this will be 
internal mail to employees, your mail server may not require it.  If you use Auto-Detect, it will be able to 
figure out your server’s policy.  If authentication IS required, you must fill in the User Name and password 
fields below. 
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User Name 
This is your E-Mail User Name, not to be confused with your SoftTIME login.  In some cases it is your full 
email address.  Auto-Detect will be able to figure out if your server requires the full address or just your 
information before the “@” sign. 

Password/Confirm 
This is your E-MAIL password.  You must enter it here twice.  Auto-Detect WILL NOT fill in your password. 

Test E-mail 
Once all the information has been entered, you can test to see if the information will work.  Click the Test 
E-mail button in the upper right.  If the E-mail was sent successfully, then you will be notified.  Otherwise, it 
will tell you why the e-mail did not send.  If the E-mail did send then go to your E-mail program and receive 
mail from the Administrator E-mail account.  If you receive the email, then you are all set. 

Default E-mail Subject 
This is the text that will appear as the default subject for generated email.  You can override this subject on 
the e-mail notification screen. 

 

Startup Settings 
To enter this mode, click on Tools->Startup Settings.  Startup Settings allow you to define how employees 
accrue time in each category.  You can set up custom settings and then apply them to categories or 
employees as needed.  There are 2 default schedules that can not be deleted, renamed, or have their 
recording modes changed: one for hours and one for days. 

This screen is very similar to the Department Settings screen in previous versions of SoftTIME. 

You can set up different startup settings for different types of employees.  When you create new employees, 
you will assign them a startup setting. 
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Startup Settings – Allowance Table 

Settings 
This is a list of all existing startup settings.  As mentioned there are 2 base templates that cannot be 
removed, renamed, or have their recording mode changed: Default Schedule Days and Default Schedule 
Hours. 

Setting Name 
This is the name of an added setting.  It will appear in the list above and elsewhere in the program where 
you choose startup settings. 

Recording Mode 
Hours Mode or Days Mode. 

Shift 
This allows you to adjust the shift of employees affected by this startup setting.  See the Adjust Shift section 
in Employee Information. 

Absence Categories 
Each setting contains information for each absence category.  Illness, Vacation, Personal or any allowed 
category allow for a detailed startup setting.  The other categories only allow you to set the Recording Year 
Type.  The following settings apply to the currently selected absence category: 
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Recording Year Type 
This sets up the start date for each employee’s recording year.  

Anniversary – Calculates from the employee’s hire date. 

Calendar – Calculates based on the standard calendar year. 

Fiscal – Calculates based on the fiscal year (the beginning of which is set in the Super Administrator Options). 

Carry Over 
This allows you to set a carry over policy for this absence category.  Checking the box allows time to carry 
over and allows you to choose whether to specify a maximum number of days or hours. 

Accrue 
This allows you to select whether time accrues at all and, if so, how long from an employees hire date they 
must wait before accrual begins. 

Allowance Table 
This is the table where you determine yearly allowances and accruals.  Here you may define accrual rates for 
an absence category.  Each row relates to a certain amount of time with the company.  For instance the first 
row might represent the rate for an employee’s first 2 years with the company.  The next row could represent 
years 2-5 and so on.  

The From and To values always refer to years.  The Yearly Allowance and Accrual Info will reflect the 
recording mode of the currently selected setting. 

Each row of the table has an Edit button.  Clicking this button will display a dialog to allow you to edit the 
accrual rules. 

 

Accruals 

Here you set the Increment and the Rate.  The Unit is defined by your setting’s recording mode.  Most of the 
rates are self-explanatory units of time.  There are 2 that warrant further explanation: 

Monthly Special 
Monthly Special is very similar to accruing by month, but you can choose exactly how much to accrue for 
each specific month (regular monthly accruals accrue the same amount for every month of the year).  You 
can also choose to not accrue for a particular month by entering in zero for that particular month. 
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TimeKron Hours 
TimeKron Hours accrues time based on how many hours the employee has recorded as worked in TimeKron.  
Just input the increment and unit as before and then enter in how many hours they have to work to earn that 
increment. 

Add Row Button 
This button adds a new row to the allowance table.  Each row will add a new year range to the setting for the 
selected absence category. 

Apply Information to Employees 
When you are changing startup settings after you have entered or imported employees into SoftTIME, you 
may apply these changes to the employees that use the specified setting.  When you press the Apply 
Information to Employees button, you will be presented with the following screen: 

 

Apply Information to Employees 

This screen displays which employees will be affected by your startup setting changes and gives you fine 
tuning over which attributes of the setting you wish to apply. 
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Holiday Editor 
To enter this mode, click on Tools->Holiday Editor.  The holiday editor allows you to customize the 
holidays that your company observes.  SoftTIME comes installed with several widely recognized holidays.  
With this editor, you can erase and add holidays.  These will apply across all employees.  This tool is only 
available to the Super Administrator. 

 

Holiday Editor 

You may select existing holidays from the Holidays list or by navigating the calendar to the right of the 
screen.  Choose the year from the dropdown list at the top of the calendar and choose the month using the 
buttons across the bottom. 

 

You have 2 tools to help you adjust your holiday calendar, the Add a Holiday tool and the Erase a Holiday 
tool. 
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The Add a Holiday tool will place a new holiday on the day on which you click it.  Upon selecting a day, you 
will be presented with the Adding a Holiday screen. 

 

Adding a Holiday 

You may choose between Fixed and Floating holiday, years to which the new holiday should apply, and 
specify a Holiday Name. 

If an employee already has an absence recorded or scheduled for the date of this holiday, this tool will not 
override the existing data. 

The Erase a Holiday tool will present the same screen, but will only allow you to specify to which years the 
erase should apply. 

 

Erasing a Holiday 
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User Defined Icons 
To enter this mode, click on Tools->User Defined Icons.  This tool allows you to customize the icons used 
for all absence categories.  This tool is only available to the Super Administrator.  It allows you to specify for 
each absence category: 

 

User Defined Icons 

 

Category Name 
Here you can change the name of any category except for holiday. 

Category Abbreviation  
A single letter is used in reports and displays where the full name cannot be displayed. 

Allowed Category 
Checking this will make the category one for which there is a budgeted allowance.  This will give more 
options in other screens such as the Startup Settings. 
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Category Color 
Clicking this color field will display a color picker dialog allowing you to choose a new color to be used as the 
category indicator where there is not room for the picture to display.  The category color is used mainly in the 
year tab, the day tab, and in the FYI screen. 

Reset Color Files 
Pressing this button updates the color files. 

Picture Abbreviation 
This text specifies what will be displayed across the bottom of the icon. 

Show name on icon 
Checking this will display the Picture Abbreviation text along the bottom of the icon. 

Original Picture Path 
Clicking this will display a file picker allowing you to choose an alternative image to represent this absence 
category. 

Reset Picture Files 
Clicking this button will update the picture files with your chosen images. 

Note - The order of the categories in this list will reflect their order in every other display in 
SoftTIME.  To change the order, select and hold down the gray box to the left of the category 
name in the list.  Your cursor will turn to an up/down arrow and you are able to drag the selected 
category to any position in the list. 
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E-Mail Notification 
This tool is found under the Reports menu.  It allows you to send e-mail notification to individual employees 
and departments with their latest attendance information.  This tool is only available to the Super 
Administrator. 

 

E-mail Notification 

You can choose Employees or Departments to refresh the displayed list.  The list is multi-select, so you can 
pick multiple employees or departments to receive your email.  You can also choose to include terminated 
employees. 

Body Style allows you to choose between 2 formats for the email.  FYI is a summary view available on the 
main SoftTIME screen.  It will look something like this: 

 

FYI Summary 
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The Employee Detail style is more of a report format and will look very much like the report of the same 
name: 

 

FYI Details 

E-mail Subject and E-mail Text allow you to customize the fields of the outgoing message. 

Department Roster 
To enter this mode, click on Tools->Departments.  The Departments screen allows you to add and remove 
departments and provide name and description information.  You can also associate departments with 
startup settings when synchronizing employees from TimeKron or other suite products.  This setting is also 
used as the default when a new employee is added into this department. 

You can also view which employees belong to which departments (this is set in the employee information 
tab).  This tool is only available to the Super Administrator.  

If you attempt to delete a department that has employees assigned to it, SoftTIME will ask you to remove all 
references to the department before deleting it. 

 

Department Editor 
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Point Categories 
To enter this mode, click on Tools->Point Categories.  The Point Categories screen allows you to add and 
remove point categories and provide name, point value, expiration and description information.  

If you attempt to delete a point category that has employees assigned to it, SoftTIME will ask you to remove 
all references to the point category before deleting it. 
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CCChhhaaapppttteeerrr   444   ---   EEEmmmpppllloooyyyeeeeee   IIInnnfffooorrrmmmaaatttiiiooonnn   
 

To enter this mode, click on the right most tab on the main screen. 

  

Employee Info Tab 

This screen defines personnel information concerning each employee. 

 

Employee Information Screen 

Administrators have read/write access to most information on this screen.  Employees only have read access. 
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Select an Employee 
You can choose which employee to view by clicking their name in the list to the left.  You can filter this list by 
changing the Department dropdown and the Show terminated employees checkbox.  All information on the 
tabs to the right of this list will reflect data for the currently selected employee.  

Administrators can also add and remove employees from the list.  Employees can only view themselves.  
Their list will only have themselves in it. 

 

 

Select an Employee 
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Add Employee 
Pressing the Add button at the bottom of the employee list will display the Add Employee screen.  Last Name 
and Hire Date are the only required fields, but you will likely want to enter all the information that you have.  

 

Add Employee Screen 

Remove Employee 
Pressing the Remove button, simply removes the selected employee from the list and from the system.  All of 
their absence information will be deleted.  If you have Deletion Warning checked in the workstation settings 
you will be asked to confirm the deletion. 

 

Remove Employee Screen 
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Employee Information 
Since most fields are self explanatory, only the fields that require an extended explanation will be discussed. 

 

Employee Info Tab 

Hire Date/Termination Date 
These dates are used in calculations and accruals.  

E-mail 
SoftTIME supports E-mail notification.  

Department 
A drop-down list of all departments used to set this employee’s department.  Departments are maintained by 
the Super Administrator in the Departments screen under the Tools menu. 
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Recording Mode 
Recording mode by default is inherited from the selected startup setting.  This control allows you to override 
this for a single employee. 

 

Recording Mode 

Default Startup Setting 
This selects the startup setting this employee will follow.  Startup Settings are maintained by the Super 
Administrator in the Startup Settings screen in the Tools menu. 

 

Default Startup Setting Selector 

Shift Information 
By default, shift information is inherited from the selected startup setting.  Here you can override shift 
information by clicking the Adjust Shift button that will display the Adjust Shift Screen as follows. 

 

 

Shift Information 
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This screen allows you to customize your employee’s shift information.  You can add another segment and 
adjust the values to account for lunch, double, or split shifts.  You can remove segments, but there must 
always be at least one active segment.  SoftTIME will not allow you to delete the last one. 

 

Adjust Shift 

Also, if you are creating a shift that spans across midnight into the next day, you must specify a Graveyard 
Shift.  Checking this box enables you to alter the baseline time of the workday to fit or assign a complete shift 
to the day on which the shift began.  The default value for baseline time is 12:00 AM.  By incrementing the 
start of your employee’s day, you can fit all of the shift segments into a single day and the time will be 
recorded on the day that the shift started on. 

Photos 
SoftTIME allows you to associate pictures with each employee.  Just click the Find button and find the picture 
for the employee.  The picture can be in GIF, JPG, or BMP format.  To remove the picture press the Remove 
button. 

 

Find Photo 
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Security Profile 
The Security options allow the Super Administrator to grant Administrator privileges to users managing 
departments and to assign which departments they have access to.  The Super Administrator can also grant 
Super Administrator access to another user. 

Administrators and Super Administrators can also change a User’s Name and Password.  Employees can only 
view their own security setting that by definition is only Employee Access. 

 

 

Security 

Notice that an administrator can be assigned to more then one department without being assigned to all 
departments.  Also the administrator's privileges can be set at one of three levels.  Clicking on an empty 
check box will give a blue checkmark, which grants the maximum level of access including the ability to 
receive leave request emails.  If you click on the blue checkmark it will change to the green check mark.  This 
second level grants full read and write access, but the user will not be notified by email of leave requests.  
Clicking a third time will change the checkmark to orange which grants access only to add or change absence 
data, but not employee data.  Clicking a fourth time will change the checkmark to yellow which grants access 
only to view employee absence data for that department, but no access is given to add or change data.  If 
you click a fifth time the checkmark will be removed and the administrator will not have any access to that 
department. 
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FYI 
At the bottom left of the main screen under the Employee List is the FYI button.  Pressing this button will 
launch the floating FYI screen. 

 

 

 

 

 

 

FYI Button 

 

FYI screen 

The FYI screen provides a summary view of all the currently selected employee’s absence category time 
information. 

Recorded 
This column displays time (in the employee’s selected recording mode) recorded for each absence category. 

Allowed 
This column displays time allowed for each category.  It only displays a value for categories set up with time 
allowances. 

Remaining 
This column shows the difference between the recorded and allowed time for categories set up with time 
allowances. 
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Absence Categories 
Each absence category may be clicked to display the Edit Category screen for that category.  Depending on 
your system privileges, this screen is either read-only or read/write.  Please see the Edit Categories section 
for more information. 

Show Scheduled Recorded Time 
By default, SoftTIME calculates recorded time on the day that it actually occurs.  Check this box if you want 
to see scheduled absences that have not yet transpired.  These will appear in the Recorded column. 

Current Points 
In the lower right portion of the FYI screen is where you can see the current employee’s current point total.  
This point total is based on all points active as of today’s date. 

Edit Categories 
This section shows how to edit category options for a specific employee.  There are multiple ways to edit 
category options from a number of different screens.  In addition to this per employee category setup you 
can set global category options in User Defined Icons and Startup Settings.  

All of these per-employee settings override the global settings. 

You can access the Edit Category Screen in one of two ways: 

FYI Screen – Single-click any category  

Main Screen (Month, Year, or Day Tab) -  Double-click any category icon 

Different categories have slightly different options based on whether they are set up for time allowances, so 
here are some sample category edit screens: 

 

Edit Category without Allowance 
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Edit Category with Allowance 

Category 
Once you have opened the Edit Category screen you can use this drop-down list to view other categories. 

Year Type 
Choose Anniversary, Calendar, or Fiscal 

Recording Year 
Select recording year to apply changes to. 

Carry Over 
Choose whether to carry over and, if so, whether to put a maximum limit on the time allowed. 

Accruals 
Select whether to accrue and, if so, at what rate.  This will override default startup setting.  To see 
explanations of accrual elements, see the section on Startup Settings. 

Yearly Allowance 
Override yearly allowance for this employee.  The rest of the fields here reflect the remaining time 
calculation.
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CCChhhaaapppttteeerrr   555   ---   MMMooonnnttthhhlllyyy   CCCaaallleeennndddaaarrr   SSScccrrreeeeeennn   
 

This screen allows Administrators to record absences, notes and make adjustments. 

 

Monthly Calendar Screen 
 

Let’s break down the components of this screen: 

Monthly Calendar 
The monthly calendar shows a full calendar for the selected employee.  It is the canvas on which all tools on 
this screen operate.  To navigate between years, use the drop-down list at the top next to the month name.  
To navigate to different months within the currently selected year, use the month buttons along the bottom 
of the calendar. 
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Monthly Calendar Tool 

Detail information 
The two panes under the monthly calendar show Day Info and Notes for the day that your cursor is currently 
over.  Day Info will display any information about the day including its absence category.  Note information 
will display any note for that day created by the Note tool. 

 

 

Detail information area 

TimeKron Type 
This option will only appear if you have SoftTIME installed as a suite with TimeKron.  It will appear below the 
calendar and above the month buttons. 

 

TimeKron Type 

This is a 3-way toggle button that will display different information on the calendar depending which state it 
is in. 

Standard 
Standard basically shuts this option off.  The calendar days will display as normal. 
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Hours Worked 
Hours Worked will show how many hours worked are logged for that employee in TimeKron on that specific 
day.  If the hours worked are more than the daily overtime set in SoftTIME (see Super Admin options), then 
the time will have a black background with white lettering.  Otherwise it will be white background with black 
lettering. 

Start Time 
Start Time will show the first punch of the day as recorded in TimeKron.  It will compare that punch with the 
shift as specified in SoftTIME.  It will apply the early and late grace periods as seen in the Super Admin 
options.  The color scheme will be as follows: 

Late - red background, white lettering 

On Time  - white background, black lettering 

Early - blue background, white lettering 

Note Tool 

 

Note Tool 

The Note tool is used to add custom notes to any day on the calendar.  First, select the Note tool, then, move 
it over the day you wish to notate and click.  It will display the note entry screen titled with the date selected. 

 

Note Entry screen 

The note will be denoted by a small pencil icon in the bottom left corner of the day.  The text of the note will 
be displayed in the note window below the calendar whenever any cursor tool is over the day. 
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Selected day contains a Note 

 

 
Note text display area 

Eraser Tool 

 

Eraser Tool 

The eraser tool will erase information on any day in the calendar.  First, select the eraser tool, then, click on 
the day you wish to erase.  It will erase any absence information.  It will erase notes and adjustments 
depending on what you have set in your Workstation Options for Auto Note Deletion and Auto Adjustment 
Deletion.  If these options are checked the notes and adjustments will be automatically deleted.  If not, you 
will be prompted as to whether to delete them or not. 

Adjustment Tool 

 

Adjustment Tool 

Adjustments are a completely new feature for SoftTIME.  Adjustments are used with allowed categories only 
to adjust overall allowed time.  They can be either positive (earning more allowed time) or negative (taking 
away allowed time).  An adjustment is made on a specific day.  The day it is made on will determine which 
recording year it gets applied to.  More than one adjustment can be made on a specific day.  This also means 
that you can make more than one adjustment for a single category on the same day. 

On the monthly screen, an adjustment is denoted on a day by a small plus (+) sign in the upper right corner 
of the day.  Adjustments will be displayed in the Day Info whenever a cursor tool is over the day. 

 

Day with adjustment recorded 

To add an adjustment, select the Adjustment tool from the Toolbar on the left and click on the day that you 
want to add the adjustment to.  The next screen will show you any adjustments already occurring on that 
day.  From here you can Add, Remove or Edit an adjustment. 
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Adjustment List 

Adding an adjustment takes you to a screen where you can choose the category, amount of the adjustment 
and note.  When you have filled out all the information, click OK and the adjustment will be added. 

 

Add and Edit Adjustment 

Each adjustment has an amount adjusted and a note. 

Editing an adjustment takes you to the same screen.  You can change an adjustment category after it has 
been entered.  Once you add, edit or remove an adjustment, you will see the allowed information for the 
corresponding recording updated. 

Removing an adjustment simply removes it from the list. 

Similar to scheduled recorded absences, adjustments will not show up in FYI until that day is reached. 
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Points Tool 

 

Points Tool 

 

Points are also a new feature in SoftTime.  The points tool is generally used outside of the absence categories 
in SoftTime, but can still be used to record absence time.  Normally, an absence in SoftTime has a fixed value 
associated with each absence:  1 Day, ½ day, 8 hours, etc.  In essence, the points feature allows you to 
change the fixed value of an absence, by creating a point category.  For example, ‘Late to work’ may be 
worth a ½ point, but ‘No Call No Show’ may be worth 5 points.  Under SoftTime’s regular absence categories, 
you can create two separate categories as in the previous example, but when marking them, they would 
have the same value.  For this reason, the points system can help to better keep track of a person’s 
absences. 

The points tool works about the same way that the adjustment tool does.  Points can be entered on any 
specific day and multiple point records can be entered for each day.  On the monthly calendar, a point record 
is denoted with an exclamation point (!) icon in the lower right of a day. 

 

Day with point recorded 

 

To add a point record, select the Points tool from the Toolbar on the left and click on the day that you want to 
add the point record to.  The next screen will show you any points already occurring on that day.  From here 
you can Add, Remove or Edit point records. 

 

Points List 
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Adding a point record takes you to a screen where you can choose the category, value of the point record, 
expiration and note.  When you have filled out all the information, click OK and the point record will be added. 

 

Add and Edit Points 

 

Each point record has a point value, expiration date and a note. 

Editing an point record takes you to the same screen.  You can change a point category after it has been 
entered. 

Every point category has specific defaults that go with it.  Most of the time, you will probably want to go with 
the default values for all point categories.  Occasionally, you may have an instance where a point record 
needs to have data other than the default.  If that is the case, uncheck the ‘Use Defaults’ checkbox.  You will 
then be able to adjust the point value and expiration fields. 

Removing a point record simply removes it from the list. 

Similar to scheduled recorded absences, points will not show up until that day is reached. 

 

Absence Tools 
Absence Tools allow you to select an absence category tool and mark any day in the calendar with it.  First, 
select an absence tool.  Your mouse cursor will turn into this tool when it is over the calendar.  Click on any 
day to assign that day the absence category. 
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Absence Tools  

At the bottom of the absence tools are buttons to scroll through the absence tools and a toggle button to 
display the absence category icons as small or large. 

Marking a day with an absence tool will overwrite any existing absence category set for that day.  It will, 
however, leave notes and adjustments intact. 

Half Day Tool 

 

Half Day Tool 

The Half Day tool changes all of the absence tools to represent a half day.  You can assign half day absences 
to any day on the calendar. 

If you assign a half day absence to a day that already has a full or half day absence you will be presented 
with the Half Day Options screen.  Here you can decide whether to overwrite the existing absence 
information or to split the day between 2 absence categories. 

 

 

Half Day Options 
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CCChhhaaapppttteeerrr   666   ---   YYYeeeaaarrr   aaattt   aaa   GGGlllaaannnccceee   SSScccrrreeeeeennn   
 

This screen allows you to record absences, notes and make adjustments for a selected employee.  The Year 
tab has all of the same tools as the Month tab and they all work exactly the same.  The only difference is in 
the cursor sizes for the tools. 

 

Year at a Glance 

Because the area to click on is smaller, be careful with your tools.  Make sure the day you want is highlighted 
before pressing the mouse button to apply the tool or absence category.  Sometimes it can be difficult to see 
the highlight.  As you mouse over a day, the date will appear in the Day Info box at the bottom of the screen. 



Chapter 7 - Day Screen 71 
 

 

CCChhhaaapppttteeerrr   777   ---   DDDaaayyy   SSScccrrreeeeeennn   
 

You may zoom into any day by clicking on the Day tab from the Main Screen.  From this screen you can 
record absences, make adjustments, and make notes. 

 

 

Day Screen 
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Selecting a Year, Month and Day 
The main navigation for this screen is in the calendar at the top right.  Use the drop-down list boxes to select 
Month and Year.  The days are selected by clicking on the resulting calendar. 

 

Selecting a Year Month and Day 

Daily Activity 
In the Day view, absence categories are displayed across the top of the screen along with their scrolling 
buttons and small/large toggle. 

 

Absence Categories 

The method for selecting and assigning an absence category is different on the Day tab.  Instead of choosing 
a tool and applying it to desired days, you simply click on the category you wish to assign to the currently 
selected day.  You will be presented with a screen to choose full or half day for the category. 

 

Day mode adding an absence 

On this screen you can choose full or half day for this category or use the drop-down list box to choose 
another category to apply.  Pressing the OK button will apply the changes to the Daily Activity list. 
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This screen is slightly different in Hours Recording Mode: 

 

Hours mode adding an absence 

On this screen you specify the length of the desired segment.  You can set the From and To times, or you 
can specify the Amount and it will calculate the To value by adding the Amount to the From time. 

 

 

Daily Activity 

If you apply an absence category and then a half day to the same day, you will be presented with the Half 
Day Options Screen just as in the monthly or yearly views. 

 

Half Day Options Screen 

The Daily Activity List behaves slightly differently depending on whether the selected employee is in Hours or 
Days Recording Mode.  If the employee is set to Hours Recording mode, you will be able to edit the From and 
To columns which will automatically adjust if there is a split.  
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TimeKron Hours 
If you have installed SoftTIME as a suite product with TimeKron, this Daily Activity grid can be used to display 
daily hours from TimeKron. 

 

The Notes text box is for keeping notes about the day.  This text will show up in the other views as notes for 
the day. 

Adjustments 
Adjustments behave similarly to the way they do on the Month and Year tabs.  The Adjustments list shows all 
existing adjustments for this day. 

 

 

Adjustments 

Pressing the Adjustment button displays the familiar Adjustment screen. 

 

Adjustment Tool 

 

Adjustment Screen 

Enter a positive or negative amount and a description.  Pressing the OK button will update the existing 
adjustment list on the Day tab. 
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You can edit adjustments directly in the Adjustments list or by double-clicking the row to launch the 
Adjustments screen. 

Remove an adjustment by clicking the red X in the last column of each row.  SoftTIME may require you to 
confirm the deletion as illustrated.  You may remove this persistent warning by un-checking the Deletion  

Warning Checkbox on the Workstation Options Screen. 
 

 

Deletion Warning 

Points 
Points behave similarly to the way they do on the Month and Year tabs.  The Points list shows all existing 
adjustments for this day. 

 

 

Pressing the Points button displays the familiar Point Record screen. 

 

Points Tool 
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Point Record Screen 

Enter a point value, expiration date and comments.  Pressing the OK button will update the existing point 
record on the Day tab. 

To edit a point record, double-click the row to launch the Point Record screen. 

Remove a point record by clicking the red X in the last column of each row.  SoftTIME may require you to 
confirm the deletion as illustrated.  You may remove this persistent warning by un-checking the Deletion  

Warning Checkbox on the Workstation Options Screen.
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CCChhhaaapppttteeerrr   888   ---   LLLeeeaaavvveee   RRReeeqqquuueeesssttt   SSSyyysssttteeemmm   
 

The Leave Request System is a tool that allows employees to request planned absences such as vacations 
and to have them approved by their administrator.  This is a simple process that begins with employee 
making a request with Leave request tool.  The employee can select My Leave Requests from the View 
menu. 

 

My Leave Requests 

Preparing a request is similar to marking an absence.  The first step is to create a new request by clicking on 
New.  Next give the request a name so that you identify it later.  In this example, Jimmy Jones will create a 
winter vacation request.  Next select the absence tool that indicates what type of leave you are taking.  In 
this example we will use the Vacation tool.  Then click on the calendars on the days that you want to take off. 
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Winter Vacation - Plan 1 

To increase the chances of getting vacation approved, Jimmy can check to see if other employees will be out 
at the same time.  To do this, he clicks on Show other conflicts.  If another employee is going to be out 
absent it will show up as an X on Jimmy's calendar. 

 

 

Winter Vacation - Conflicts 

Since some other employees will be out on the 22nd, 23rd, and 24th, Jimmy will have better chances of 
getting his vacation requested if he chooses a different week instead.  To erase the unwanted days, first 
Jimmy clicks on the day he wants to erase.  This will highlight the day in the Requested Day List.  Then 
Jimmy clicks on Delete. 



Chapter 8 - Leave Request System 79 
 

 

Delete an absence from the Requested Days list 
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After adjusting his leave request, Jimmy can add some additional notes to his request.  At this point the 
request is in DRAFT mode.  That means Jimmy is still fine-tuning his request.  Once he is ready to send it to 
his administrator for approval he can click on Submit. 

 

Delete an absence from the Requested Days list 

Once the request is submitted the administrator will be able to view it and approve the request.  If you are 
using the Email Notification system and have properly configured your Email settings then SoftTIME will 
submit the Leave Request by email to all applicable administrators. 

 

When the administrator logs into SoftTIME he will see the requested leave icon on the bottom of his screen. 

 

Icon indicating someone has requested leave 

The administrator can then either click on this icon or click on Leave Approval from the Tool menu. 
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From inside the Leave Approval Tool the administrator can see all the leave requests that have been 
submitted and are pending his approval. 

 

Delete an absence from the Requested Days list 

As the administrator you have three options you can take with each leave request.  You can Approve it, 
Deny it, or send it back to the employee for Re-Draft.  To help you make your decision, you can check the 
database to see if other employees will be absent on the same days.  Click on Show Conflicts to see a list 
of potential problems. 

 

To see potential problems with the requested days click on Show Conflicts 
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This screen will show all the conflicts for employees that work in departments that you administer. 

 

 

Display Conflict Check 

Since Karen and Nathan work in accounting, Monday will be clear for Jimmy from administration.  However, a 
lot of people have already been approved for vacation on New Year's Eve.  Lets see if we can convince Jimmy 
to come into work on Friday. 

 

Send back for Re-Draft 

We can make a short note and send the request back to Jimmy for Re-Draft. 
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When Jimmy logs back into SoftTIME he will see the leave request information available icon on the bottom 
of his screen.  This lets Jimmy know that his request was either approved, denied, or sent back for Re-Draft. 

 

Icon indicating leave request information is available 

Jimmy can click on the icon to see what status his request has. 

 

Request in Re-Draft status 

Jimmy can adjust his request by removing Friday and then Submit the request again for approval. 
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The administrator can Approve the request with one click 

Everything looks good and the administrator can now approve the request.  Once approved the absence is 
recorded on the main calendar and will show up as a projected absence in the FYI screen. 

 

The request has been approved 

With the winter vacation request approved, Jimmy can book his villa in the snow filled mountains. 
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CCChhhaaapppttteeerrr   999   ---   RRReeepppooorrrtttsss   
 

There are 3 categories of reports that can be selected from the Reports Menu: 

• Employee Reports 

• Department Reports 

• Miscellaneous Reports 

• Points Reports 

Employees only have access to the employee reports. 

Common Report Features 
There are several attributes common to all the reports that should be covered up front. 

 

Report Title 
This is the title that will appear at the top of each report page.  This is editable unless the administrator has 
checked the Administrator Title Lock. 

Report Description 
This is a brief description of the report. 

Administrator Title Lock 
May be used by an Administrator to lock the Report Title 

Low Resolution Printer 
This option will refrain from adding fancy shading and other styles to the report. 

Company Logo in Header 
This allows you to place a logo image in the header of the report.  This image is defined in the Super 
Administrator Options. 



SoftTIME User Manual 86 
 
Company Name in Title 
This allows you to print the company name in the title of the report.  This name is defined in the Super 
Administrator Options. 

Preview 
This button will allow you to Preview the report before printing, emailing or creating an HTML document. 
In the Preview mode, a Report Preview Toolbar will appear on the screen  

 

The Report Preview Toolbar allows you to select any portion of the report you want to view.  With the 
Report Preview Toolbar you can: 

• Move to the first or last page of the report 

• Move to the previous or next page of the report 

• Move to a specific page in the report 

• View one, two or four pages at a time 

• Zoom in or out of the report 

• Print the report 

• Close the Preview window 

E-mail 
This button will allow you to e-mail the report to an employee or manager.  After clicking on the E-mail 
button the following screen will appear: 
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The report’s title is in the upper left part of the form.  If you want to see the e-mail that will be sent, you 
can click the Preview button.  In the lower left part of the form, you can enter the e-mail subject and any 
additional text you want to include.   

The list on the right is a list of employees and their e-mail addresses, if they have one.  To add an 
employee to the recipient list, double click the employee or click the recipient and click the Add button.  If 
you want to include a recipient that is not in the list, click the “Add Other Recipient”, which is located 
above the Recipient List.  A window will appear. Enter the e-mail address of the recipient and click OK. If 
you want to send an email to all employees within a department, click Departments, and select the 
department(s). Only employees with e-mail addresses will receive the report. 

Once you have selected one or more recipients, the Send E-Mail button will become enabled.  When you 
have selected all the recipients, click this button and it will start sending the E-mails.  The Send Log 
section in the lower right will display the sending progress. 

HTML 
This button will allow you to create and save an HTML document.  When the Save Window appears, give 
the HTML document a name and click Save. 

Employee Reports 
Employee Reports allow you to create printouts for a specific employee or for all the employees in a selected 
department.  

• Annual Summary 

• Employee Details 

• Employee Information 

• Employee Profile 

• Month at a Glance 

• Year at a Glance 
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• Employee FYI 
 

There are some common attributes across many of the employee reports that will be covered here. 

Employee vs. Department 
Each of the employee reports has an employee/department list, and you can select either employees or 
departments.  The list below will reflect your choice.  This is a multiple-select list box, so you can hold down 
your <CTRL> or <SHIFT> keys to select multiple employees or departments. 

If you select one or more departments, the report will scroll through each employee in the selected 
departments. 

Include Terminated Employees 
This is a filter on the employee/department list allowing you to choose whether to show terminated 
employees. 

Date Range/Recording Year/Report Months 
Each employee report, except for the Employee Information report, has some method of specifying the time 
segment that the report represents.  

A date range specifies a start and end date for the report. 

A recording year specifies a complete year to report on. 

Report Months allows you to choose a year and specific months on which to report. 
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Annual Summary Report 
The Annual Summary Report allows you to print a year calendar and to select which absence categories will 
be represented by their abbreviations.  The report has a legend along the bottom to help in interpreting these 
abbreviations. 

You also have the option of printing a blank year. 

 

Annual Summary Parameters 

See the following report illustration: 

 

Annual Summary Sample 
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Employee Details Report 
The Employee Details report lists details of each absence for a single employee for a date range you select 
(see illustration). 

You can select absence categories to appear on the report or show them all.  A legend at the bottom shows 
the Activity Codes and Date Range selected. 

On the selection screen use the button icon under the Date Range field to specify whether you also want to 
print notes that have no associated absences. 

To print a list of all employee notes for the date range, click Print Notes Only.  The report excludes any 
absence without a note.  It is designed to print only notes.  

You may also choose whether to show Adjustments and TimeKron Hours. 

 

Employee Details Parameters 

See the following report illustration: 

 

Employee Details Sample 
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Employee Information Report 
This following report basically summarizes the information entered on the Employee Information tab of 
SoftTIME’s main screen. 

 

 

Employee Information Parameters 

 

See the following Employee Information report illustration: 

 

Employee Information Report Sample 
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Employee Profile Report 
This report will print absence, accrual, and carry over data for the selected category types.  The Report 
Parameters screen is shown as follows: 

 

Employee Profile Parameters 

For each recording year selected, the report will display its type (anniversary, calendar, fiscal).  For the 
allowed absence categories, it shows: the Yearly Allowance, Carry over time, Accrual time and start date, 
Accrual formula (if applicable), Adjustments, Total Allowed Time, Total Recorded Time, and Total Remaining 
Time. 

Recorded absence times are then shown for each of the “other” categories.  The report also displays, in text 
and graphically, the current shift assigned to that employee. 

The categories shown in the report can be chosen by the user.  You can choose all the categories or just one.  
For just a single recording year selected, 5 categories can usually fit on one page. 

See the following report illustration: 
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Employee Profile Sample 
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Month at a Glance Report 
This report shows all absences for a single employee, for any month, or months, you select.  It’s a calendar-
month view designed for managerial review, distribution to the employee or placement in the employee’s 
personnel folder. 

 

Employee Month at a Glance Parameters 

Click the Print Blank check box to generate an empty, monthly calendar for planning or general reference. 

If Show Icons is selected and SoftTIME is in Hours Recording mode, the report will not show multiple 
absences for a given day.  A single icon fills the entire daily space.  Select Text Only and the report will print a 
list of all absences that occurred that day, and the duration of each. 

Each report will print one month for one employee, per page.  A sample report follows. 

 

Month at a Glance sample 
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Year at a Glance Report 
This report prints the allowed and recorded time for a single employee.  To print the recorded time for 
multiple employees, use the annual summary report.  The annual summary report will not include allowed 
time due to potential conflicts with multiple recording years. 

This report shows all absences for an employee, on a sheet, displaying every month in the employee’s 
reporting year.  Selection of multiple employees is not available.  A report must be printed after each 
selection.  If the reporting or Recording Year for the employee begins on any day other than the first of a 
month, the report will display the 13 consecutive monthly calendars required to view the span of the 
particular year. 

 

 

Employee Year at a Glance Parameters 

You choose which Recording Year to print.  Only those recording year types (calendar, anniversary, fiscal) 
associated with the current employee will be displayed; all others will be disabled (grayed). 

The report includes a summary of absences recorded, allowed and remaining for the three major SoftTIME  
categories, as well as recorded information alone for the six categories not having “allowed” and “remaining” 
attributes.  

If you check the Show scheduled recorded time checkbox, time recorded in the future is included in the 
totals, i.e. when a planned future absence is recorded in advance. 
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A sample Year at a Glance Report follows: 

 

Year at a Glance Report Sample 

Employee FYI 
This report prints current FYI information for the selected employees. 

 



Chapter 9 – Reports 97 
 

 

Employee FYI Parameters 

A sample Employee FYI Report follows: 

 

Year at a Glance Report Sample 
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Department Reports 
SoftTIME’s Department Reports provide customized reports at the department level.  These reports 
summarize information across all employees in the selected department.  Some of them also allow employee-
level reporting. 

• Absence Report 

• Absence Summary 

• Adjustment Report 

• Allowance Projection 

• Annual Overview 

• Daily Report 

• Department Details 

• Department Reconciliation 

• Lateness Details 

• Lateness Summary 

• Monthly Report 

• Quick List 

• Shift Analysis 



Chapter 9 – Reports 99 
 

Absence Report 
This is an “Exception Report” on employee absences above or below your specified limit within the selected 
date range.  The unique part of the report screen is the “operators” list box, just below the Date Range 
controls. 

 

Absence Report Parameters 

The operator list (just underneath the date range parameter) allows you to select whether the report will 
contain the people with absences equal to, greater than, less than, or one of the other comparisons to 
the value entered into the field directly below the operator list. 

 

Operator list 

The report, as illustrated, shows all employees and their absence numbers that correspond to the statement 
at the top of the Report Parameters screen: 

 

 

Absence Report Sample 
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Absence Summary Report 
This report summarizes absences for each employee in a department.  Time recorded to be taken in the 
future is included in the total.  All absence types are shown on the report, but it does not reflect holidays. 

 

Absence Summary Parameters 

See the following report illustration: 

 

Absence Summary Sample 
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Adjustment Report 
This is one of the Department reports that allow you to select both employees and departments.  The 
Adjustment Report allows you to print a summary of all adjustments in the selected categories for the 
selected employees or departments. 

 

 

Adjustment Report Parameters 

 

A sample Adjustment Report follows: 

 

Adjustment Report Sample 
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Allowance Projection Report 
This report projects allowed time as it will appear on a specified future date or at the end of the current 
recording year. 

 

Allowance Projection Parameters 

See the following Allowance Projection Report illustration: 

 

Allowance Projection Department Sample 
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Allowance Projection Individual Sample 
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Annual Overview Report 
This report shows the weeks during which an employee took an absence for a selected year.  The report will 
either shade, or place a code letter in, each week during which the specified absence occurred. 

Only one absence category can be selected at a time.  
 

 

Annual Overview Parameters 

The following report illustration shows two employees requesting an overlapping vacation: 

 

Annual Overview Sample 
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Daily Report 
This report lists all absences for a selected day.  Use it to answer information requests concerning a specific 
day or as a daily hand-out to managers. 

 

Daily Report Parameters 

See the following Daily Report illustration: 

 

Department Daily Report 
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Department Details Report 
This report format is designed to spot abusive patterns and possible personnel shortages.  It shows absences 
and any scheduled absences recorded in advance, for employees in the department, aligned by date. 

 

Department Details Parameters 

See the following Department Details Report illustration: 

 

Department Details Sample 
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Department Reconciliation Report 
The Department Reconciliation report compares absences taken with absences allowed for the allowed 
absence categories.  A unique feature of this report is the Report Options box. 

 

Department Reconciliation Parameters 

The first option will print information for all employees for the selected recording year.  If you are using 
anniversary or fiscal years, some employees may span 2 different recording years.  To solve this problem, 
select the second option that automatically includes data for any recording year (calendar, fiscal or 
anniversary) that includes the specified date. 

See the following Department Reconciliation Report illustration: 

 

Department Reconciliation Sample 
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Lateness Details Report 
The Lateness Details Report is only available when using SoftTIME as a suite with TimeKron.  If you try to go 
into this report screen and you aren’t connected to the TimeKron, you will see the following message: 

 

 

TimeKron Alert 
 

This report gives you a day-by-day list of employee lateness. 

 

Lateness Detail Parameters 

One feature to note is that you can also include employees that are on time in the report. 

A sample Lateness Details Report follows: 

 

Lateness Details Sample 
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Lateness Summary Report 
The Lateness Summary Report is only available when using SoftTIME as a suite with TimeKron.  This report 
gives you an aggregate list of selected employees or departments late time for the specified date range. 

 

Lateness Summary Parameters 

A sample Lateness Summary Report follows: 

 

Lateness Summary Report Sample 
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Monthly Report 
This report prints names and dates absent for everyone in a department charged with a single absence type, 
in the selected month. 

The Report Parameters screen below has a pair of Report Format radio buttons, allowing you to choose:  

Calendar Report – an actual (one-month) calendar, with absentee names filled in (reveals absence patterns)  

Detail Report – a list of names, days and dates (more compact, easier to read) 
 

 

Monthly Report Parameters 
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A sample Monthly Report in Calendar Format follows: 

 

Monthly Report Calendar Format Sample 

 

A sample Monthly Report in Detail Format follows: 

 

Monthly Report Detail Format Sample 
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Quick List Report 
This report enables the user to produce customized columnar reports.  The control screen for the report is 
illustrated as follows: 

 

 

Quick List Parameters 
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Parameter Function 
Report Title The user can enter any title for this template. 

 

 
In this scenario the word “template” and the word “report” are synonymous. 

Column 1 through 
Column 7 

The user can specify the data to be displayed in each column of the report. 

 

 
Each Column control is a drop down list box allowing the user to select from the 
following data: 
 

• <Blank> 
• Name 
• Department 
• Startup Setting 
• E-mail 
• Hire date 
• Birth Date 
• Termination Date 
• SSN 
• Employee # 
• Rec. Mode 
• TimeKron Hours 
• Shift 
• All of the Absence Categories 

 
Some data fields will allow the user to get more detailed information.  For absence 
category data, the user may also specify: 
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Parameter Function 

 
 
For example, if the user were to specify Illness for Column 2, he can then also 
specify “Accrued”.  In this case, only Accrued Illness will appear on the report for 
Column 2.  

 
 
In order to access the secondary drop down list box, the Recording Year Option must 
be checked on the Quick List Parameter Screen. 

 

Recording Year Checkbox 

 
Departments The user can select a single department, multiple departments (click departments 

while holding the Ctrl-Key), or –All Departments-. 

 

 
The user can even select –Unassigned Department- which will report on employees 
that have not been assigned to a Department. 
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Date Option The user can specify a desired date range, or select an entire recording year.  If the 

user checks “Current Recording Year”, data from the remainder of this year will be 
reported 

 
 

Show Recorded 
Time Details 

If the box is checked, recorded details can appear in the report.   

 
 

If this box is not checked, only summary data will be printed in the report.  If the box 
is checked details will print in addition to summary data. 

Export Clicking on this button will allow the user to export the specified data in this template 
to be exported to a file.  For more on this subject, see Export. 

 
 
Supported file types are: 

• .xls – Microsoft Excel.  Once in this format you can then export the data to 
most payroll programs. 

 
• .csv – Comma Separated files.  Generally used for mail merges. 

 
• .txt – Windows text file.  This file can be edited with Notepad or Word. 

 
• .dbf – a FoxPro Table.  This is very useful if you have a programming staff 

that wishes to provide you with a report that does not exist in SoftTIME.  You 
may also export data from this format in Microsoft SQL with relative ease. 

 
New If you wish to create a new template, click the “New Button”.  A default template will 

appear.  You may then configure the template as you would like.  When you are 
done, you may want to save the template for a future date.  Remember to give the 
template a good name (Report Title) so you can find it again next month. 

Open You can retrieve a saved template by clicking on this button and then specifying the 
name of the template file.  Template files end with the extension “.QK”. 

Save You can save your current selection as a template.  Later, you can recall the 
template by using the “Open Button”. 

Print You can print the results of your selection to the printer of your choice. 
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Preview You can preview the results of your selection before you send it to the printer.  This is 

generally a good idea. 
OK Click this button when you are finished.  But, remember to save your template with 

the “Save” Button before you exit. 
 

Following are 2 reports generated from this Quick List control screen: 

 

Quick List Sample 1 

 

 

Quick List Sample 2 
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Shift Analysis Report 
This report compares shift, time segments for all employees in a department.  

 

Shift Analysis Parameters 

A sample Shift Analysis Report follows: 

 

Shift Analysis Report Sample 

An outlined record with the asterisk indicates a graveyard shift. 
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Miscellaneous Reports 
This menu gives you access to a number of helpful reports: 

 

• Anniversary List 

• Birthday List 

• Department List 

• Holiday Details 

• Holiday List 

• Holiday Reconciliation 

• Startup Settings 
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Anniversary List Report 
This report lists, by month, employee anniversary dates (date of hire).  It also shows calculated years of 
service.   

 

Anniversary List Parameters 

 

A sample Anniversary List Report follows: 

 

Anniversary Report Sample 
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Birthday List Report 
This report lists a department’s employee birthdays for selected months or a year (click Print Entire Year in 
the parameters screen).  The report begins with employees having unknown birthdays and then lists the 
names and birthdays in the selected months.  If a month is void of birthdays, its heading will not print. 

 

Birthday List Parameters 

A sample Birthday List Report follows: 

 

Birthday List Sample 
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Department List Report 
This report shows a list of departments and their employees.  You have the option whether to show 
departments without employees. 

 

 

Department List Parameters 

A sample Department List Report follows: 

 

Department List Sample 
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Holiday Details Report 
This report gives a list of all holidays taken and not taken for each selected employee. 

 

 

Holiday Details Parameters 

 

A sample Holiday Details Report follows: 

 

Holiday Details Sample 
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Holiday List Report 
This report lists all company holidays recorded in the Holiday Editor screen. 

If no holidays are specified for the selected calendar year, no report will print.  It’s a good idea to distribute 
this list to employees at the beginning of each year. 

 

Holiday List Parameters 

 

A sample Holiday List Report follows: 

 

 

Holiday List Sample 
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Holiday Reconciliation Report 
This report shows a detailed reconciliation of all holidays taken for each employee in the selected 
departments. 

 

Holiday Reconciliation Parameters 

A sample Holiday Reconciliation Report follows: 

 

Holiday Reconciliation Sample 
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Startup Settings Report 
The Startup Settings report allows you to select a startup setting and print out all of its settings for each 
category. 

 

Startup Settings Parameters 

Categories show the information they have, so categories with allowances show full startup settings, 
recording year, and carry over data while others simply show recording year type. 

A sample Startup Settings Report follows: 

 

Startup Settings Sample 
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Points Reports 
This menu gives you access to a number of helpful reports: 

 

• Perfect Attendance 

• Point Details 

• Point Infractions 

• Point Ledger 

• Point Totals 

• Excessive Points 

 

Perfect Attendance 
The Perfect Attendance report allows you to report on employees who haven’t had any absences or points for 
a specified number of days.  You can also choose which absences and points qualify for this report. 
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A sample Perfect Attendance Report follows: 

 

 

 

Point Details 
Every employee in the system has a current ‘point’ total.  This report shows how that total was derived.  This 
shows the details of every point record that is still on the books. 
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A sample of the Point Details report: 

 

Point Infractions 
This report shows details of point infractions for a specified date range. 

 

 

 

A sample of the report: 
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Point Ledger 
This report shows a balance sheet of point information for a specified time period.  Includes a starting 
balance, point occurrences, as well as point expirations. 

  

  
 

 

 

A sample of the report 
follows:
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Point Totals 
Similar to the Point Details report, this report gives current totals only for each employee. 

 

 

A sample of the report follows: 

 

 

Excessive Points 
This report allows you to query the database about how many points your employees have. 
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A sample of the report follows: 
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CCChhhaaapppttteeerrr   111000   ---   UUUtttiiillliiitttiiieeesss   
 

Importing Data 
SoftTIME supports importing data from a variety of other software programs and other versions of SoftTIME.  
There are two options in SoftTIME for importing data into your database.  One option is to use the DBADMIN 
mode to do a Total Import (see Total Import Instructions in Chapter 2). 

Under the file menu there is another utility for importing data into your SoftTIME database.  Before using this 
utility you will need to setup your data as you want it.  This utility is primarily used to add employees and 
departments to your SoftTIME database that you have already setup.  This can even be used to add 
employees to a SoftTIME database that you are using.  To use this utility you must be operating in Super 
Administrator mode. 

To begin importing data, select File->Import from the menu.  SoftTIME features an Import Wizard to lead 
you through the steps of importing your data. 

 

File Menu 

 

SoftTIME Import 
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Select the type of file you wish to Import.  The file types supported are as follows: 

Generic Data File 

SoftTIME (Includes all older versions, Pro, Lite, and Xp) 

SelecTime 2000 (Includes all Single User and Network versions) 

SoftTIME Diamond 

Click Next>>. 

Depending on the Import File Type chosen, the Import Wizard will display different screens to gather 
information appropriate to the file type: 

Generic Data File 
Choose whether to import Employee or Department Data by clicking on the appropriate check box. 

 

Generic Import - Step 2 
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Next you must choose the Generic Data File to Import.  It is helpful to use the first row of your import file as 
headers.  These will display in the next step when you have to map the column names.  Generic Data File 
types can be xls, txt, csv, dbf, etc. 

 

Generic Import - Step 3 

With generic data file imports, you will need to match the SoftTIME Fields to the fields in the import file.  
SoftTIME will try to match the fields as best it can.  All of the fields do not have to be matched, but to move 
to the next step, you must match up the name field.  You can match up fields by selecting a field and using 
the << and >> buttons or by dragging and dropping between the lists. 

 

Generic Import - Step 4 
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Duplicate Handling tells SoftTIME how you wish it to handle duplicate records that it comes across.  Your 
choices are to skip or to allow duplicate records.  Skipping will not import a record identified as a duplicate.  
Allowing duplicates will import the record and you can review both records in SoftTIME to determine which is 
valid. 

 

Generic Import - Step 5 

Press the Finish button and the import will begin. 
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Importing from SoftTIME 
This option applies to all previous SoftTIME products: SoftTIME Lite, SoftTIME XP, etc. 

When importing from a previous version of SoftTIME, choose the SoftTIME file type and select the directory 
where the previous version is installed, NOT the data directory. 

Step 3 differs in that you must match up the categories between the 2 versions.  SoftTIME will do its best to 
guess these for you, but review them and make any changes you desire.  You can match up fields by 
selecting a field and using the << and >> buttons or by dragging and dropping between the lists. 

 

SoftTIME Import - Step 3 

Duplicate Handling is described above in Step 5 under Generic Data File. 

Press Finish to start the import. 

 

SelecTime 2000 and SoftTIME Diamond follow the same flow as SoftTIME (above). 

 

A progress bar will show the progress of the import.  After you have completed the import, review your data.  
Make sure your new data was imported as expected and check for duplicates. 
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Exporting Data 
SoftTIME’s Quick List Export utility also serves as a report generator.  You may choose up to 7 data fields to 
export or print.  You can select department and date filters.  There are also pre-defined, customizable reports 
covered in the Reports section of this document. 

Data can be exported to 4 different file types: xls, csv, txt, and dbf. 

 

Export/Print Report 

Report Title 
This text will appear at the top of the report.  It will NOT be displayed in the export file. 

Columns 1-7 
Each of these drop-down list boxes allows you to choose from any of the available data fields.  They will 
appear in the order you specify.  They default to a common selection of data elements.  

<Blank> can be selected for a column if you do not want any data in that column. 

In the report all columns are of equal width.  If any data is longer than this width, the data will wrap to the 
next line of the column.  

For an export, the first row of the specified file will be the column title. 
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If any column is selected and the information requested is recorded time, you have the option of showing the 
recorded time details.  The checkbox will appear at the top if you want to see the details. 

 

If any allowed category is selected and the information requested is adjustments, you have the option of 
showing the adjusted time details.  The checkbox will appear at the top if you want to see the adjustment 
details. 

 

If TimeKron Hours is selected, you have the option of showing the TimeKron Hours details.  The checkbox 
will appear at the top if you want to see the TK Hours details. 

 

Departments 
You can filter the report or export by a single department.  The default is All Departments. 

Include Terminated Employees 
This is a filter to include or exclude employees no longer with the company. 

Date Option 
This option allows you to specify a date range for the data.  The default is the current month.  You can also 
select the current reporting year or specify a reporting year.  Choosing Date Range for the Date Option will 
mean that only Recorded time will be available for any category information.  Either of the other recording 
year options allows all information. 

Low Resolution Printer 
This option is for printing only.  It will optimize the report for a low resolution printer. 

Company Logo in Header 
This option allows you to include a graphic of your company logo in the header of the report.  This is for 
printing only.  The source file for the graphic is set in the Super Administrator options. 

Company Name in Title 
This is for printing on reports only. 

New/Open/Save Buttons 
These buttons allow you to save an export/report configuration in order to open it and run it in the future.  
Pressing the New button will reset all fields to the default.  Any of these operations will present you with a 
dialog to specify the name of the template you wish to open, save, or create. 
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Export Button 
Pressing this button will initiate the export.  You must choose a file name and location with the file picker 
window.  SoftTIME will alert you when the export is complete.  Export will not save any of the detail 
information (absences, adjustments, TK hours). 

Print Button 
This button will print this report to your Windows default printer. 

Preview Button 
This button will launch the print preview window allowing you to preview the report before printing it.  You 
can also print from this window to your default printer. 

 Printer Setup  
The Print Setup option is under the File menu.  It allows you to pick from a list of recognized printers or to 
browse the network to locate a printer. 

 

Printer Setup 

Help Menu 

 

Help Menu 
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License Agreement 
The License Agreement can be seen at the beginning of this User’s Manual. 

Upgrade License 
This utility allows you to upgrade your number of user licenses for SoftTIME.  This screen will have your 
current activation code and your current number of licenses.  You can call up your SoftTIME vendor, 
purchase the additional codes, and you will be given a new activation code to upgrade to the newly 
purchased number of user licenses. 

 

Upgrade License 

Once you enter the new activation code and press the OK button, SoftTIME will exit.  The next time you 
enter the program, the new number of user licenses will be activated. 

Web Update and Automatic Upgrades 
This feature allows you to automatically check www.softwaretech.com for recent upgrades and patches.  If 
you would like to set the interval for performing these checks, you can run the Web Update option from the 
Help menu. 
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Web Update Settings 
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If a new version is available via the web an Icon will appear in the bottom left corner of the main screen: 

 

Web Update Available 

To download the web update, click on the web update icon .  This will do two things.  First it will 
download the update files to the auto-upgrade directory (hopefully) on your network.  You will need to have 
read/write and file creation access to this directory to successfully download updates.  Once the files are 
downloaded they will automatically be installed on your workstation.  You will then probably need to restart 
SoftTIME.  Most upgrades will not require you to reboot. 

Each time you attempt to login to SoftTIME, the software will automatically check the auto-upgrade directory 
to see if your workstation is running the most recently downloaded version of the software.  If you need to 
upgrade your workstation you will see a screen that will require you to update. 

 

Automatic Upgrade Notification 

As you upgrade your old SoftTIME executable will be backed up and a progress bar will be displayed.  After 
completing the upgrade you will have to restart SoftTIME. 

 

Automatic Upgrade Progress 
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Sometimes an upgrade will require that the Database is also upgraded.  SoftTIME constantly checks the 
database to make sure it is compatible with the software.  If the database and the application become out of 
sync, you should have your DBA run SoftTIME in DB Administration mode. 

More Sources for Help 

Software Techniques on the WEB 
This option launches your default Web browser to Software Techniques, Inc. main Internet site.  The web 
URL is http://www.softwaretech.com. 

 

 

STI Website 

 

Technical Support Options 
This screen shows information about how to get help with your SoftTIME product. 

 

Technical Support Options 

About SoftTIME 
The About SoftTIME screen gives information about your installed version of SoftTIME.  It is useful if you ever 
need to make a support call to give your version, serial number, etc. 

http://www.softwaretech.com/
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About Screen 
 

DB Administration Mode 
Database Admin mode is demonstrated in Chapter 2 – Installation and Setup.  If you are using the SQL 
version, find the section entitled Database Connection and Setup – SQL version on how to use DB Admin 
mode.  If you are using the Diamond version, find the section entitled Database Connection and Setup – 
Diamond version. 
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CCChhhaaapppttteeerrr   111111   ---   TTTrrrooouuubbbllleee   SSShhhooooootttiiinnnggg   
 

Technical Support 
If the information you need to solve a problem is not in the manual, please do the following: 

1. Review the list of Common Problems and Solutions that follow, to see if your problem is there 

2. You can also receive on-line support via our Technical Support Web Page on the Internet at  
http://www.softwaretech.com.  Product support is free for the first 15 days that you own 
SoftTIME.  Beyond that time, support and E-mail calls are billable. 

3. Refer to the Microsoft Windows User Manual for help with problems caused by the operating 
environment or the Windows Graphic User Interface. 

If steps 1-3 were not able to help, you may call Software Techniques Inc. at (540) 721-1002 for technical 
support.  Our staff is on duty Monday through Friday, from 9:00 AM - 12:00 PM and 1:00 PM - 5:00 PM, 
Eastern Time.  You may also FAX your questions to us at (540) 721-1010.  Before you call, though, complete 
the following steps: 

1. Be sure you are eligible.  Product support is free for the first 15 days that you own 
SoftTIME.  Beyond that time, support and E-mail calls are billable. 

2. Have the SoftTIME serial and version numbers handy.  You can find them on the installation 
diskettes, and copy them here:  

Activation Code _____________________ Version # ________ 

3. Note the amount of available disk space on your drive, _____________ and the amount 
of RAM on your computer _________________.  Also, note the available disk space within 
your common directory ____________. 

4. Verify your ODBC connection is working properly.  Write down the name of the SQL Database 
you are connecting to.  [____________________]  (It should appear on the main screen in 
[brackets]). 

5. A problem may be database related so have your SQL DBA near by in case he needs to be 
consulted.  Also make sure you have full read/write/create privileges to your common 
directory. 

6. If an error has occurred, write down the first error message exactly as it appears on your 
screen.  Write down the steps you took just before the error message appeared.  

7. Be prepared to provide our Technical Support staff with any information they need.  
SoftTIME generates a log file that may help us diagnose complex problem.  We may ask you 
to send this file to us for analysis. 

http://www.softwaretech.com/
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Common Problems and Solutions 

 My Password doesn’t work. 

  The first time you log in, the system defaults to a User Name of “Admin”.  No 
Password is required.  Just press Enter and you will be logged in to the software. At 
this point, you can set up individual User Names and Passwords by clicking on the 
Employee Information tab. 
Remember, the password field is case sensitive. Check your caps lock key. 
You can also adjust your workstation options for each individual 
workstation. 

 Error Message - Cannot locate FoxPro Support Library. 

 The computer does not have the FoxPro DLL files installed.  These can be 
obtained by reinstalling the software.  Make sure the data files are backed 
up before reinstalling. 

 Computer freezes when trying to load SoftTIME. 

 Your workstation probably does not meet the minimum requirements.  
Make sure that no other programs are running in the background.  If the 
problem still occurs, change the display on the video driver to a standard 
Super VGA display. 

 I receive the following error message: 
 “Unable to login to SoftTIME.  Common directory does not exist.” 

 You are unable to connect to the common directory.  If it is on a network, 
make sure you are properly connected and logged in to that network.  
Check your network cable.  If the problem continues contact your network 
administrator. 

 I receive the following error message: 
 “Unable to login to SoftTIME.  Invalid ODBC Connection.” 

 You are unable to connect to the SQL Database.  This may be because your 
SQL Server is down or because your SQL account does not let you connect 
to the database.  If the problem continues contact your SQL DBA. 

 I receive the following error message when trying to login: 
 “SQL Command w/ error [UPDATE ...]”. 

 The SQL DBA has restricted your use of the database (permissions) such 
that you cannot properly access the database in the required fashion.  It 
has been altered into an unusable format.  Have your SQL DBA run 
SoftTIME in DB Admin mode and use the configuration tools to repair the 
problems. 
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 Printer display reads: Memory Overload. 

 Turn the printer Off and On.  Go to your desktop, click Start-Settings-> 
Control Panel->Printers.  Reduce the print resolution to the next lowest 
level.  Set up the report for printing again. 

 Also, 2MB of printer memory is recommended. 

 Error Message - Unable to Write to file named _________. 

 SoftTIME  cannot write to your hard drive or to the common directory.  The 
most common problem is insufficient disk space.  Free up some disk space.  
This can also occur if your network administrator has restricted your access 
to the common network directory  

 Error Message during installation - Unable to Read _________. 

 This may be a bad CD or a bad CD Drive.  First remove the CD and reboot 
your computer.  Reinsert the CD after you have logged back into Windows  
If the problem continues call Technical Support and report the exact error 
message that appears.  The technical support staff can issue you a new CD. 

 Error Message - Unable to Update Cursor. 

 The user logged on to the network does not have read/write access to the 
common data directory.  This is most likely a network rights issue. 

 Installation or Update Error Message - Can’t change properties of file 
named _________. 

 User requires write access to the Windows directory so that SoftTIME can 
automatically update the .DLL files 

 Sometimes the menu options are disabled and I cannot click them. 

 You probably have too many screens open.  Close some screens down. 

 Where is the half day tool? 

 The Half Day icon will appear for employees in the 'day' recording mode 
only.  You can use the daily absence screen to specify the exact time of the 
absence. 

 After importing, SoftTIME asked me if I wanted to exit and I said no, 
SoftTIME exited anyway.  Why? 

 After importing, it is always best to exit and restart SoftTIME.  This is to 
ensure that the import was successful. 
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 I receive the following error message: 
 “Unable to login to SoftTIME.  Base data is incomplete”. 

 The SQL database has been altered into an unusable format.  Most likely a 
critical table has been deleted.  Have your SQL DBA run SoftTIME in DB 
Admin mode and use the configuration tools to repair the problems.  If data 
has been lost have your SQL DBA restore a SQL backup. 

 I receive the following error message: 
 “SQL Command w/ error [SELECT ...]”. 

 The SQL database has been altered into an unusable format.  Have your 
SQL DBA run SoftTIME in DB Admin mode and use the configuration tools 
to repair the problems. 

 Some words in SoftTIME may be cropped. 

 The font size on the video card is set to large fonts.  Change the font size to 
small fonts.
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PROGRAM LICENSE AGREEMENT 

 
 

Copyright/License/Warranty 
SoftTIME Diamond Edition ® Copyright © 2016 by Software Techniques Inc. 
SoftTIME D/SQL Server ® Copyright © 2016 by Software Techniques Inc. 
All rights reserved. 
 
One registered copy of SoftTIME Diamond Edition or SoftTIME D/SQL Server may be 
used simultaneously by multiple people not to exceed the number of authorized users 
specified by the product purchased.  Whereby the number of authorized users 
concurrently operating the program is subject to purchase license. 
 
You may access the registered version of SoftTIME Diamond Edition or SoftTIME 
D/SQL Server through a network, provided that you do not exceed the total number of 
users set forth by the product. 
 

Governing Law 
The laws of the Commonwealth of Virginia shall govern this agreement. 
 

Disclaimer of Warranty 
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR 
ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.  In particular, 
there is no warranty for any data entered into SoftTIME Diamond Edition or SoftTIME 
D/SQL Server.  Because of the various hardware and software environments into 
which SoftTIME Diamond Edition or SoftTIME D/SQL Server may be put, NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE CAN BE OFFERED. 
 
ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT.  
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